
Caméra PTZ 4K : créativité et excellence.

AW-UE160
La caméra PTZ 4K AW-UE160 est dotée d’un nouveau capteur MOS 4K
d'un pouce qui offre la sensibilité la plus élevée de toute la gamme
PTZ de Panasonic. Les équipes de production qui tournent dans une
salle de concert ou une église peuvent facilement capturer des images
claires, même dans les conditions d’éclairage les plus
difficiles. Pendant ce temps, le nouveau filtre passe-bas optique de
l’UE160 réduit l’effet de moiré pour une qualité d’image plus claire lors
de la prise de vue contre un mur LED, ce qui est particulièrement
important pour les environnements de location et de mise en scène
ou de culte. Sa fréquence d’images haute vitesse aidera les diffuseurs
sportifs à capturer des prises de vue au ralenti en HD pour les
rediffusions, tandis que l’intégration transparente avec le système de
caméra robotique apporte des mouvements de style diffusion en
direct au PTZ, résultant en une production vidéo dynamique et très
engageante.

Key Features

Performances des captations et opérabilité sans compromis

Le filtre optique passe-bas réduit considérablement

Capteur 4K nouvellement développé offrant une sensibilité
supérieure

Autofocus amélioré grâce à une technologie avancée

Prise en charge SMPTE 2110 avec achat d’une clé logicielle
supplémentaire

Realize next-generation video production with various
shooting methods and functions.

Ease of use and versatility reduces stress of shooting on-site.



AW-UE160

https://eu.connect.panasonic.com/fr/
fr/broadcast-proav/remote-ptz-
camera-systems/aw-ue160

General -> Power Requirements 12 V DC ± 10% (10.8 V to 13.2 V)
General -> PoE PoE++


IEEE802.3bt standard: DC 42 V to 57 V (Camera Input) 

(Software authentication (LLDP) is supported).

General -> Current Consumption 5.0A (XLR IN connector), 1.5A (PoE++ power supply)
General -> Ambient Operating
Temperature

0 °C to 40 °C (32 °F to 104 °F)

General -> Ambient Operating
Humidity

20 % to 90 % (no condensation)

General -> Storage Temperature –20 °C to 50 °C (–4 °F to 122 °F)
General -> Weight Approx. 4.6 kg (10.14 lbs) (excluding mount bracket)
General -> Dimensions W 213 mm x H 277 mm x D 240 mm


(8.39 inches x 10.91 inches x 9.45 inches)

(excluding protrusions, ceiling mount bracket)

General -> Finish AW‑UE160W: Pearl white

AW‑UE160K: Black

General -> Controller Supported See the "Compatibility Chart for Operation Devices and Application Software" page
Camera Unit -> Imaging Sensor 1-type 4K MOSx1
Camera Unit -> Effective Pixels Approx. 9,620,000 pixels
Camera Unit -> Zoom ・Optical zoom: 20x


・i.Zoom: UHD 24x, FHD 32x

・D.Extender zoom: 1.4x, 2x

Camera Unit -> Lens Motorized Optical 20x zoom, F2.8 to F4.5

[f=8.8 mm (11/32 inches) to 176.0 mm (6-15/16 inches),

35 mm (1-3/8 inches) equivalent: 24.5 mm (31/32 inches) to 490.0 mm (19-9/32 inches)]

Camera Unit -> Conversion Lens Not supported
Camera Unit -> Angle of View Range Horizontal angle of view: 75.1° (wide) to 4.0° (tele)


Vertical angle of view: 46.7° (wide) to 2.3° (tele)

Diagonal angle of view: 82.8° (wide) to 4.6° (tele)

Camera Unit -> Optical Filter -> ND
Filter

Through, 1/4, 1/16, 1/64 , (Through is used as “Night mode”)

Camera Unit -> Focus Switching between auto and manual
Camera Unit -> Focus Distance Entire zooming range: 1000 mm (3.3 ft)


Wide end: 100 mm (0.33 ft)
Camera Unit -> Color Separation
Optical System

1MOS

Camera Unit -> Standard Sensitivity F14 / 2,000lx (Low Light), F11 / 2,000lx (Normal) (59.94Hz)

F15 / 2,000lx (Low Light), F12 / 2,000lx (Normal) (50Hz)

Camera Unit -> Horizontal Resolution -
> 4K

1,600 TV lines Typ (Center area)

Camera Unit -> Gain Selection Auto, -6 dB to 12 dB 
Camera Unit -> Frame Mix<sup>
*2</sup>

Auto, 0 dB, 6 dB, 12 dB, 18 dB, 24 dB 

Camera Unit -> Electronic Shutter
Speed -> 60p

1/60, 1/100, 1/120, 1/125, 1/250, 1/500, 1/1000, 1/1500, 1/2000

Camera Unit -> Electronic Shutter
Speed -> 59.94p/59.94i

1/60, 1/100, 1/120, 1/125, 1/250, 1/500, 1/1000, 1/1500, 1/2000

Camera Unit -> Electronic Shutter
Speed -> 50p/50i

1/60, 1/100, 1/125, 1/250, 1/500, 1/1000, 1/1500, 1/2000

Camera Unit -> Electronic Shutter
Speed -> 29.97p

1/48, 1/50, 1/60, 1/96, 1/100, 1/120, 1/125, 1/250, 1/500, 1/1000, 1/1500, 1/2000

Camera Unit -> Electronic Shutter
Speed -> 25p

1/48, 1/50, 1/60, 1/96, 1/100, 1/125, 1/250, 1/500, 1/1000, 1/1500, 1/2000

Camera Unit -> Electronic Shutter
Speed -> 23.98p/24p

1/48, 1/50, 1/60, 1/96, 1/100, 1/200, 1/125, 1/250, 1/500, 1/1000, 1/1500, 1/2000

Camera Unit -> Electronic Shutter
Speed -> 59.94p/120fps

1/125, 1/250, 1/500, 1/1000, 1/1500, 1/2000

Camera Unit -> Electronic Shutter
Speed -> 50p/100fps

1/125, 1/250, 1/500, 1/1000, 1/1500, 1/2000

Camera Unit -> Synchro Scan -> 60p 60.00 Hz to 7200 Hz
Camera Unit -> Synchro Scan ->
59.94p/59.94i

60.00 Hz to 7200 Hz
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Camera Unit -> Synchro Scan ->
50p/50i

50.00 Hz to 7200 Hz

Camera Unit -> Synchro Scan ->
29.97p

30.00 Hz to 7200 Hz

Camera Unit -> Synchro Scan -> 25p 25.00 Hz to 7200 Hz
Camera Unit -> Synchro Scan ->
23.98p/24p

24.00 Hz to 7200 Hz

Camera Unit -> Synchro Scan ->
59.94p/120fps

120.00 Hz to 7200 Hz

Camera Unit -> Synchro Scan ->
50p/100fps

100.00 Hz to 7200 Hz

Camera Unit -> Gamma HD / NORMAL / CINEMA1 / CINEMA2 

MASTER GAMMA (0.15～0.75)

R GAMMA (-75～+75)

B GAMMA (-75～+75)

R BLACK GAMMA (-20～+20)

B BLACK GAMMA (-20～+20)

Camera Unit -> White Balance ATW  : 3200K, 5600K

AWB : AWB-A / AWB-B

VAR (selectable between 2000K and 15000K by designating a value)

Camera Unit -> Chroma Amount
Variability

OFF, –100 % to 40 %

Camera Unit -> Scene File Scene1 to 8
Camera Unit -> Color Bar<sup>
*9</sup>

SMPTE

Full Bar

ARIB (FHD) : FSTD-B28

ARIB (UHD) : FSTD-B66

ARIB (BT.2020/HLG)

Camera Unit -> Output Format
(SDI) ->
4K

2160/60p, 2160/59.94p, 2160/50p, 2160/29.97p (Native), 2160/25p (Native), 2160/24p
(Native), 2160/23.98p (Native)

Camera Unit -> Output Format
(SDI) ->
HD

1080/119.88p  , 1080/100p  , 1080/60p, 1080/59.94p, 1080/50p,
1080/29.97p (Native), 1080/25p (Native), 1080/24p (Native), 1080/23.98p (Native),
1080/59.94i, 1080/50i, 720/59.94p, 720/50p

Camera Unit -> Output Format
(HDMI)
-> 4K

2160/60p, 2160/59.94p, 2160/50p, 2160/29.97p (Native), 2160/25p (Native), 2160/24p
(Native), 2160/23.98p (Native)

Camera Unit -> Output Format
(HDMI)
-> HD

1080/119.88p, 1080/100p, 1080/60p, 1080/59.94p, 1080/50p, 1080/29.97p (Native),
1080/25p (Native), 1080/24p (Native), 1080/23.98p (Native), 1080/59.94i, 1080/50i,
720/59.94p, 720/50p

Camera Unit -> Output Format(Fiber
(video only)) -> 4K

2160/59.94p, 2160/50p, 2160/29.97p (Native), 2160/25p (Native), 2160/24p (Native),
2160/23.98p (Native)

Camera Unit -> Output Format(Fiber
(video only)) -> HD

1080/60p, 1080/59.94p, 1080/50p, 1080/29.97p (Native), 1080/25p (Native), 1080/24p
(Native), 1080/23.98p (Native), 1080/59.94i, 1080/50i, 720/59.94p, 720/50p

Camera Unit -> Output Format(ST
2110)

1080/60p, 1080/59.94p, 1080/50p, 1080/29.97p (Native), 1080/25p (Native), 1080/24p
(Native), 1080/23.98p (Native), 720/59.94p, 720/50p

Synchronization System Internal/External synchronization (BBS/Tri-level sync)
Input Connector -> DC IN DC 12 V IN
Input Connector -> G/L IN BBS (Black Burst Sync), tri-level sync supported
Input Connector -> AUDIO INPUT ->
XLR

XLR (2ch) or MIC/LINE Input compatibles (SDI/HDMI/IP)

  AAC compatibility (compatible with IP only)

XLR 3-pin female balanced input: 2ch

• During MIC input

  Input level: –50 dBu or -60 dBu/-40 dBu (0 dB=1 V/Pa, 1 kHz)

  Phantom power compatible, Supply voltage: 47 V±2 V

  Input impedance: Approx. 10kΩ

• During LINE input

  Input level: 0 dBu (or +4 dBu/-20 dBu)

  Input impedance: Approx. 10kΩ

• Input volume variable range: -40 dB to 0 dB to +20 dB (1 dB step)

• Embedded audio output level: -12 dBFS/-18 dBFS/-20 dBFS

• Sampling frequency: 48 kHz

• Quantization bit rate: 24 bit (SDI/HDMI), 16bit (IP)

Output Connector -> HDMI HDMI 2.0 standard

4:2:2/10bit  

Output Connector -> 12G-SDI OUT SMPTE2082_1, SMPTE424M/SMPTE292M/ 75 Ω (BNC x 1) 
Output Connector -> 3G-SDI OUT1 SMPTE424M/SMPTE292M/ 75 Ω (BNC x 1) 
Output Connector -> 3G-SDI OUT2/PM SMPTE424M/SMPTE292M/ 75 Ω (BNC x 1) 
Output Connector -> SFP+ SFP+ compliant (Single Fiber) , MSA standard compliant product
Output Connector -> USB USB3.0 HOST 5G mobile router (with USB tethering support 
Input/Output Connector -> LAN LAN connector for IP control (RJ‑45) 100BASE-TX/1000BASE-T
Input/Output Connector -> RS-422 CONTROL IN RS-422A (RJ‑45)
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Input/Output Connector -> SFP+（ST
2110）<sup> *12</sup>

Compatible protocol:

• ST 2120-10/-20/-21/-22/-30

• PTP ST 2059-1/2

• NMOS IS-04/IS-05

Number of outputs:

[Uncompressed] Video x3 (Main line, Crop, Monitor), Audio x2

[ JPEG XS] Video x1 (Main line, Crop), Audio x2

Number of inputs: Video x1 (RETURN)

Video format: FHD, UHD 

Please refer to the operating instruction manual.

Pan-tilt Head Unit -> IP connecting
cable

• With PoE++ ethernet hub

LAN cable  (category 5e or above, straight cable) up to 100 m

• Without PoE++ ethernet hub

LAN cable  (category 5e or above, straight cable) up to 100 m 

Pan-tilt Head Unit -> AW protocol
connecting cable

LAN cable  (category 5e or above, straight cable) up to 1000 m

Pan-tilt Head Unit -> Installation
Method

Stand-alone (Desktop) or suspended (Hanging) 

Pan-tilt Head Unit -> Pan/tilt Operation
Speed

0.08 °/s to 180°/s (Normal mode) 

Maximum speed:

Normal mode: 60°/s, Fast1 mode: 90°/s, Fast2 mode: 180°/s

Pan-tilt Head Unit -> Panning Range ±175°
Pan-tilt Head Unit -> Tilting range –30° to 210° 
Pan-tilt Head Unit -> Quietness NC35 or less 
Supported Operating Systems and
Web Browsers -> Windows<sup>
*11</sup>

Windows®10

Microsoft Edge

Google Chrome

Supported Operating Systems and
Web Browsers -> Mac<sup>
*11</sup>

macOS 10.13 / Safari 13

macOS 10.14 / Safari 13

macOS 10.15 / Safari 13

macOS 10.15 / Google Chrome

Supported Operating Systems and
Web Browsers -> iPhone/iPad<sup>
*11</sup>

iOS

Safari

iPadOS

Supported Operating Systems and
Web Browsers -> Android<sup>
*9</sup>

Android OS

Google Chrome

IP Streaming -> Image Streaming
Mode

JPEG (MJPEG), H.264, H.265, NDI® High Bandwidth, NDI® HX  

IP Streaming -> Image Resolution 3840x2160, 1920x1080, 1280x720, 640x360
IP Streaming -> Image Transmission
Setting ( JPEG)

Frame Rate: Maximum 30 fps  

Image quality (Fine / Normal)

IP Streaming -> Image Transmission
Setting (H.264) -> Transmission Type

Unicast port (AUTO)

Unicast port (MANUAL)

Multicast port

IP Streaming -> Image Transmission
Setting (H.264) -> Transmission mode

CBR, VBR

IP Streaming -> Image Transmission
Setting (H.264) -> Frame Rate

[60Hz] 5fps / 15fps / 30fps / 60fps (UHD: 30fps, 60fps)

[50Hz] 5fps / 12.5fps / 25fps / 50fps (UHD: 25fps, 50fps)

IP Streaming -> Image Transmission
Setting (H.264) -> Max Bit Rate

2048kbps / 4096kbps / 8192kbps / 10240kbps / 12288kbps / 14336kbps / 20480kbps /
24576kbps / 51200kbps / 76800kbps

IP Streaming -> Image Transmission
Setting (H.265) -> Transmission Type

Unicast port (AUTO)

Unicast port (MANUAL)

Multicast port

IP Streaming -> Image Transmission
Setting (H.265) -> Transmission mode

CBR, VBR

IP Streaming -> Image Transmission
Setting (H.265) -> Frame Rate

[60Hz] 30fps / 60fps

[50Hz] 25fps / 50fps

IP Streaming -> Image Transmission
Setting (H.265) -> Max Bit Rate

2048kbps / 4096kbps / 8192kbps / 10240kbps / 12288kbps / 14336kbps / 20480kbps /
24576kbps / 51200kbps / 76800kbps

IP Streaming -> Audio Compression
Format

AAC-LC, 48 kHz / 16 bit / 2ch

IP Streaming -> Supported Protocol ->
Network Protocol

ICMP, ARP, GARP, MLD

IP Streaming -> Supported Protocol ->
Transmission Protocol

TCP/IP, UDP/IP

IP Streaming -> Supported Protocol ->
IPv6

IPv4: HTTP, HTTPS, DNS, NTP, DHCPv6, MDNS, SNMP, 802.1X

IP Streaming -> Supported Protocol ->
IPv4

IPv6: HTTP, HTTPS, DNS, NTP, DHCPv4, MDNS, SNMP, 802.1X

IP Streaming -> Supported Protocol ->
Video Streaming Protocol

RTP / RTCP over RTSP, RTMP, RTMPS, SRT, MPEG2-TS over UDP, NDI® high bandwidth ,
NDI® HX
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IP Streaming -> Supported Protocol ->
External Device Cooperation Protocol

FreeD, TSL5.0, SNMP

NDI<sup>®</sup> Support ->
NDI<sup>®</sup> Support

NDI®(High Bandwidth NDI®, NDI®|HX Ver.2)  

NDI<sup>®</sup> Support -> Output
Format (NDI<sup>®</sup> High
bandwidth) -> 4K

2160/59.94p, 2160/50p, 2160/29.97p, 2160/25p, 2160/24p, 2160/23.98p

NDI<sup>®</sup> Support -> Output
Format (NDI<sup>®</sup> High
bandwidth) -> HD

1080/60p, 1080/59.94p, 1080/50p, 1080/29.97p, 1080/25p, 1080/24p, 1080/23.98p,
720/59.94p, 720/50p

NDI<sup>®</sup> Support -> Image
Resolution (NDI<sup>®</sup> HX)

1920x1080, 1280x720 

NDI<sup>®</sup> Support -> Image
Streaming Setting (NDI<sup>®</sup>
High bandwidth) -> Transmission
Type

Transmission Type: TCP/UDP

Unicast/Multicast

NDI<sup>®</sup> Support -> Image
Streaming Setting (NDI<sup>®</sup>
High bandwidth) -> Max Bit Rate

Max 250 Mbps

NDI<sup>®</sup> Support -> Image
Streaming Setting (NDI<sup>®</sup>
HX) -> Transmission Type

TCP/UDP

Unicast/Multicast

NDI<sup>®</sup> Support -> Image
Streaming Setting (NDI<sup>®</sup>
HX) -> Flame rate

[60Hz] 5fps / 15fps / 30fps / 60fps

[50Hz] 5fps / 12.5fps / 25fps / 50fps

NDI<sup>®</sup> Support -> Image
Streaming Setting (NDI<sup>®</sup>
HX) -> Max Bit Rate

512kbps / 768kbps / 1024kbps / 1536kbps / 2048kbps / 3072kbps /4096kbps /
6144kbps / 8192kbps / 10240kbps / 12288kbps / 14336kbps / 16384kbps / 20480kbps /
24576kbps

NDI<sup>®</sup> Support -> Audio
Compression Type
(NDI<sup>®</sup> High bandwidth)

AAC, 48 kHz, 2 ch

NDI<sup>®</sup> Support -> Audio
Compression Type
(NDI<sup>®</sup> HX)

AAC-LC, 48 kHz,16 bit, 2 ch

Other Function -> VR Support
(IP/RS422)

Supported

ST 2110 -> Supported Format ST 2110: 10/20/21/30

PTP: ST2059-2

NMOS: IS-04/IS-05

ST 2110 -> Number of Outputs (TX) ->
Video

3 channels (Full x 1, MONI x 1, Crop x 1)

ST 2110 -> Number of Outputs (TX) ->
Audio

2 channels

ST 2110 -> Number of Outputs (TX) ->
Auxiliary data

No output

ST 2110 -> Number of Inputs (RX) ->
Video

1 channel (RETURN) 

ST 2110 -> Number of Inputs (RX) ->
Audio

No input

ST 2110 -> Number of Inputs (RX) ->
Auxiliary data

No input

ST 2110 -> Output Format -> Video
format

Full x1, MONI x1, Crop x1, all the same format

1080/60p, 1080/59.94p, 1080/50p, 1080/59.94i, 1080/50i, 1080/29.97p (Native),
1080/25p (Native), 1080/24p, 1080/23.98p (Native), 720/59.94p, 720/50p

ST 2110 -> Output Format -> Audio
specifications (MIC1/2)

PCM / 48kHz / 24bit / 1ch x2

ST 2110 -> Input Format 1080/60p, 1080/59.94p, 1080/50p, 1080/59.94i, 1080/50i, 1080/29.97p (Native),

1080/25p (Native),1080/24p, 1080/23.98p (Native), 720/59.94p, 720/50p

Optional Accessories -> Wireless
Remote Controller

AW‑RM50AG (Size "AA" dry battery x2, obtained separately)
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Footnote Description * NDI® is a registered trademark of Vizrt NDI AB in the United States and other countries.



Limited in function when PoE used.

IP only.

Connection with digest authentication is not guaranteed to work in a case where you are
using a Panasonic Controller ( AW-RP150, AW-RP60 ). Smooth operation may be
diminished when connection with digest authentication. Use host authentication or the
HTTPS function.

Equipped with Low pass filter.

Can be set in 1dB step increments.

If format is set in 2160/29.97p, 2160/23.98p, 2160/24p, 2160/25p,
1080/29.97p,1080/25p, it cannot be set.

HLG is set in other menu.

ATW Speed 3-stage variables

The color bar on the IP display is not compliant with SMPTE.

1080/119.88p and 1080/100p use two 3G SDI OUT1/2 channels.

No output from 12G/SDI.

Requires activation with the separately sold Operational Software Key AW-SFU60.

HDCP is not supported.

Viera Link is not supported.

Compatible with Level-A/Level-B.

Optical signal input not supported.

Limited power supply to USB_Wifi dongle.

Follows the system format.

STP (Shielded Twisted Pair) is recommended.

Use Category 6 or higher for 4K video transmission.

For safety reasons, it must be secured with the included mounting hardware.

Depending on the PAN/TILT position, the main unit may be reflected in the video image.

NC25 or less when P/T is stationary.

NDI® is a new live video production workflow support protocol for IP use developed by
NewTek, Inc.

NDI® is a registered trademark of NewTek, Inc. in the United States and other countries.

No bit rate specified.

JPEG and H.264, JPEG and H.265 simultaneous operation depends on bit rate.

NDI® has no image resolution specifications.

NDI®|HX has no output format specifications.

Output from 3G SDI OUT2 (Video is changed in the OSD menu)


